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1 INTRODUCCION

En la actualidad, la presién sobre la sustentabilidad de los recursos naturales estd en aumento,
debido al crecimiento exponencial de la poblacién mundial, acrecentando la demanda por los
alimentos y explotaciéon de los recursos suelo y agua (Xu y Singh, 2004). A este escenario se suma los
potenciales impactos del cambio climatico a nivel global. En el tercer informe del Panel Inter
gubernamental para el Cambio Climatico indica que existe una variacién en la temperatura y la
precipitacion, produciendo cambios en la disponibilidad del agua a nivel de cuenca (IPCC, 2001).

Muchas de las comunidades andinas de Bolivia dependen en gran medida de los recursos hidricos
generados en cuencas de alta montafias. Una limitante para el entendimiento de la oferta de recursos
hidricos en cuencas de alta montafia es la escasa informacién de variables hidro climaticas, de ahi la
importancia del uso de diferentes técnicas y modelos que permitan representar con suficiente
precisién dicha informacién y posteriormente extrapolar su desempefio a cuencas con similares
caracteristicas hidroldgicas v fisiograficas.

En este documento se presentan los resultados obtenidos en la modelacidn hidrolégica superficial de
la cuenca correspondiente al Rio Sajama localizada en el departamento de Oruro. Respondiendo al
indicador siete de la propuesta técnica, presentada en mayo 2013, cuyo objetivo principal es
“Estudiar la oferta de agua superficial e inferir potenciales impactos del cambio climatico (en la oferta
de agua superficial), en una region del Parque Nacional Sajama” corresponde al Proyecto:” Los
bofedales como un aliado en la resiliencia y mitigacién del cambio climatico". Referencias al Proyecto
asi como sus antecedentes se detallan en los Términos de Referencia (TDR) y Propuesta Técnica. El
presente documento se desarrolla basado en los TDR mencionados y al correspondiente Contrato
Civil por Servicios de Consultoria.

La presente pasantia es llevada a cabo por solicitud de Agua Sustentable. Durante el desarrollo del
mismo, se agradece la participacidon del Ingeniero Freddy Soria por la colaboracién en la revisién
literaria, guia en el procesamiento y anadlisis de la base de datos. También se agradece el valioso
apoyo del personal técnico de agua sustentable en la recoleccidn de datos de campo.

2 PROCESOS Y HERRAMIENTAS UTILIZADAS

2.1 Area de estudio

El area de estudio comprende la cuenca del rio Sajama, que es parte del Parque Nacional Sajama
(PNS). Se encuentra entre los 17°55’ - 18°15’ de latitud sur y 68°40’- 69°10’ de longitud oeste, en un
rango altitudinal de 4102 a 6436. La cuenca del rio Sajama cuenta con un area total de 557,36 km’
(Figura 1). La zona presenta siete meses del afio secos, temperaturas minimas medias bajo cero a lo
largo de todo el afio, asi como todos los meses con heladas nocturnas, Estos factores, asi como la
amplitud térmica diaria (19,1°C) limitan el desarrollo de la agricultura en la zona, por lo que la
actividad econémica principal radica en la crianza de camélidos (Liberman 1986 y Garcia 2012, citado

por Lorini 2012).
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Figura 1. Ubicacién de la cuenca en estudio.
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2.2 Estructura del modelo matematico semidistribuido de balance hidrico superficial

A diferencia de cuencas de climas templados con morfologia homogénea, el modelo matematico semi
distribuido de balance hidrico superficial, estd desarrollado para cuencas hidrogréaficas de alta
montafia que presentan una morfologia relativamente heterogénea como es la cuenca del rio Sajama.

Al final de la temporada seca las cuencas hidrogréficas dependen de la cantidad total de lluvia
efectiva (precipitacién menos evapotranspiracion potencial) y en el inicio de la temporada de lluvias,
la mayor parte de la precipitacion se infiltra y muy poca escorrentia es producida. En la temporada de
Iluvia como sucesivamente la precipitacion es mas frecuente, los poros y micro poros de la estructura
del suelo se llenan de agua hasta llegar a su capacidad méxima de retencién de agua, produciendo la
escorrentia y percolacion. Cada zona de la cuenca tiene diferente capacidad de retencion de agua por
lo que contribuye a la recarga del rio principal de la cuenca, con un cierto volumen, en diferente
momento.
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El modelo semidistribuido de balance hidrico superficial mencionado, se basa en el trabajo de Collick
et al. (2009), bajo el principio de que las diferentes partes de la cuenca contribuyen con escorrentia a
la corriente en diferentes momentos. Para definir las zonas tributarias, la cuenca se sub divide en
zonas, donde cada una cuenta con un esquema que describe el balance hidrico de manera
independiente. Cada region o zona de la cuenca empieza a contribuir a la recarga de agua, mediante
aportes de aguas subterraneas (acuiferos profundos), flujo lateral y escorrentia superficial cuando el
suelo alcanza un contenido de humedad umbral denominado Tn.x (Collick et al. 2009). A diferencia de
Soria (2012), la estructura tiene un esquema discretizado de manera diferente.

En los siguientes sub titulos se describen conceptos y estructura del modelo Hidroldgico
semidistribuido de Collick et al. (2009).

a) Modelo de balance hidrico Superficial
El esquema general para el modelo de balance hidrico superficial, estd basado en la expresion
general del balance de humedad en el suelo (Ojha y Singh 2002, citado por Soria, 2012).

b) Balance de humedad del suelo

El modelo estima el volumen de almacenamiento de agua por unidad de area S(L), utilizando
la precipitacion P(L/T), la evapotranspiracion real AET(L/T), escorrentia superficial R(L/T),
percolacion profunda Perc (L/T), y el tiempo de almacenamiento anterior S, (T). La ecuacioén
para el balance de humedad del suelo para un intervalo de tiempo At es el que sigue (Collick

etal. 2009):
S¢ =Si_at + (P — AET — R — Perc)At (1).
Ojhay Singh (2002) citado por Soria (2012), resume la anterior ecuacién en: ’
dS/dt=(P— AET Q) o
y

Donde el volumen de almacenamiento de agua por unidad de drea S (L) durante un paso de
tiempo t, estd determinado por la precipitacion P (L/T), la evapotranspiracion actual o real
AET (L/T) y el escurrimiento total de la cuenca Q (L/ T) que es la contribucién de la recarga de
agua mediante la percolacién profunda Perc y el escurrimiento superficial R.

Se debe considerar que el escurrimiento superficial R es inexistente bajo condiciones aridas
o suelos con alta tasa se infiltracion y Perc, el cual se determina a través del coeficiente de
escorrentia Cse (Soria, 2012).

c¢) Evapotranspiracion real AET
La ecuacién para el célculo de la evapotranspiracion real AET, es la siguiente (Collick et al.
2009):
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AET = PET (Tsf ) 3).

Donde la evapotranspiracion actual AET, estda determinado por la evapotranspiracion
potencial PET, el volumen de almacenamiento S; y la capacidad de almacenamiento de
humedad en el suelo por unidad de drea Tmax(L).

Durante la época de lluvias, cuando las precipitaciones superan la evapotranspiracion (P>
PET) o el contenido de humedad esta por encima de la capacidad de campo, la humedad de
almacenamiento S;, se determina a partir de la adicion de la humedad del dia anterior S; (L)
a la diferencia entre P y PET, durante el paso de tiempo. En la época seca, cuando la
evaporacion excede la precipitacion (P <PET) y el contenido de humedad del suelo esta por
debajo de la capacidad de campo, la evapotranspiracién real AET (L/T) disminuye linealmente
a partir de la tasa potencial en capacidad de campo a cero en el punto de marchitez
(Thornthwaite y Mather 1955, citado por Collick et al. 2009).

Cuando la evaporacion excede la precipitacion (P <PET), la humedad de almacenamiento
durante un paso de tiempo t puede escribirse como una funcidon exponencial (Lyon et al.
2004, citado por Collick et al, 2009):

St [exp (w)] (4).

Tmax

Cuando la lluvia excede la evaporacion (P> PET), se afade la precipitacion neta al
almacenamiento del dia anterior (Collick et al. 2009).

St = St—At + (P - PET)At (5).

d) Contribucién de la percolacion y escorrentia superficial
Cuando la precipitacidon satura completamente el suelo, el agua en exceso Ex, (L/T) se
convierte en escorrentia superficial o se filtra a los acuiferos (percolacién profunda).
Considerando que la humedad existente en el suelo S; es igual que la capacidad de
almacenamiento de agua en el suelo T, (ecuacién 7), el exceso de agua después de la
saturacion del suelo se puede determinar mediante la siguiente ecuacién modificada de la
ecuacion original presentada en Collick et al. (2009):

Ex,, = (Si_pt + P — PET) — Typux (6).
St = Tmax (7).

Por encima del valor umbral T,, el exceso de humedad se divide entre percolacion y
escorrentia (Collick et al. 2009).
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Perc = fEx,, (8).
R=(1-B)Exp (9).

Donde 8 es el coeficiente de escorrentia utilizado como un pardmetro de calibracién. La
percolacion contribuye a un deposito de flujo base RS (L/P), en un paso de tiempo (Easton et

al. 2007, citado por Collick et al. 2009).

RSt = RSt—At + (Perct - BFt—At)At (10).

Donde BF; es la cantidad modelado de flujo base (L/T) y se calcula usando un modelo de
yacimiento lineal siguiente:

[1—exp(—aAt)]

BFt = RSt At

(11).

Donde a (1/T) es el coeficiente de recesidn, una propiedad del acuifero y puede ser calibrado
del flujo base de la curva de recesién y At es el paso del tiempo (Easton et al. 2007, citado por
Collick et al. 2009).

2.3 Delimitacién y division de la cuenca en zonas

La delimitacion de la cuenca se realizo mediante el programa ArcGis 9.3, que cuenta con
herramientas hidroldgicas que permiten modelar el flujo de agua a través de una superficie de un
Modelo de Elevacién Digital (DEM). Para delimitar automaticamente una cuenca hidrografica y
construir la red hidrica a partir de un DEM con la ayuda del programa ArcGis, se realizé el siguiente
procedimiento:

a) Obtencidn y proyeccion del DEM
El DEM utilizado se obtuvo de la base de datos de Agua Sustentable, cuenta con pixeles de
30x30m. El archivo raster no contaba con una proyeccion por lo que por medio de la caja de
herramientas Arc Toolbox, se definid la proyeccién al sistema de coordenadas UTM WGS
1984 (ArcToolbox > Data Management Tools > Projections and Transformations > Raster >
Project Raster).

b) Eliminar imperfecciones del DEM
Una vez definida la proyeccién se uso la herramienta Fill, que permite rellenar vacios en la
superficie del raster para quitar imperfecciones en la informacidon del DEM (ArcToolbox >
Spatial Analyst Tools > Hydrology > Fill).

c) Definir la direccion de la red hidrica
Por medio de la herramienta Flow Direction, se creé un raster con la direccion de flujo de
cada una de sus celdas, para el cual se uso el DEM sin imperfecciones, para definir la direccién
de la red hidrica (ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direction).
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Determinar la acumulacién de la red hidrica

El programa simula el curso de una gota de agua desde la parte mas alta de la cuenca hasta la
parte en que se va acumulando, mediante la herramienta Flow Acumulation que crea un
raster del flujo acumulado para cada una de sus celdas. La entrada de esta herramienta es el
archivo raster generado con la herramienta Flow Direction (ArcToolbox > Spatial Analyst Tools
> Hydrology > Flow Accumulation).

Delimitacion automadtica de la cuenca

Para delimitar la cuenca hidrografica se apoyo en la herramienta Basin, que elabora un raster
delineando la cuenca en base al raster creado con la herramienta Flow Direction (ArcToolbox
> Spatial Analyst Tools > Hydrology > Basin).

Con la herramienta Raster to Poligono se transformo el raster obtenido en el proceso anterior
a shapefile (ArcToolbox > Conversion Tools > From Raster > Raster to Polygon).

Para el uso del modelo hidrolégico semidistribuido de balance de humedad en el suelo, se dividié Ia

cuenca en cuatro zonas tributarias (figura 2). Estas zonas se identificaron a partir del porcentaje de

vegetacién existente, altitud, el porcentaje de pendiente, textura del suelo y otras caracteristicas

como la presencia de nieve acumulada en la superficie. La division de la cuenca en formato digital se

realizé mediante el programa ArcGis 9.3., a través de la superficie de un Modelo de Elevacion Digital

(DEM) y un raster de indice de Vegetacidn de Diferencia Normalizada (NDVI), el Gltimo muestra la

cantidad y calidad de cubierta vegetal en la superficie de la cuenca. Otro de los pardmetros de

entrada para el modelo hidroldgico es el area de cada zona tributria identificada, esta informacion se

muestra en el cuadro 1.
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Figura 2. Division en zonas de la cuenca del rio Sajama.
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Cuadro 1. Superficies de cada zona tributaria de la cuenca.

Alturas
cop Zona (msnm) Area m’ Area km’
min | max
1 Nevados 5020 6436 58512891,29 58,51
2 Alta 4460 5020 236576237,41 236,58
3 Media 4320 | 4460 94326982,83 94,33
4 Baja 4102 4320 167945733,95 167,95

2.4 Parametros y principales entradas del modelo

La precipitacion y la evapotranspiracién son los principales datos de entrada para el modelado
hidrolégico de la cuenca. La cuenca en estudio fue dividido en una serie de aéreas, donde cada area
tiene su propia Tmax (mm/mes) o capacidad maxima de almacenamiento de agua en el suelo. Este
almacenamiento debe ser llenado antes de crearse la escorrentia superficial. El modelo es sensible a
los datos de precipitacion, ETP (evapotranspiracion potencial) y a parametros como el coeficiente de
escorrentia y el coeficiente de recesion. Los datos de precipitacion y otros insumos usados en el
modelo se describen en las siguientes secciones.

a) Precipitacion y ETP

Los datos de la variables hidroldgicas consideradas en el modelo provienen de tres estaciones
meteorologicas. Los datos fueron utilizados en funcién a la altura que corresponde a cada zona:
Chungara Ajata correspondiente a la zona altas y nevados; Estacion Comisario perteneciente a la zona
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media y la Estacidn Sajama abarca la zona baja. Las fechas disponibles de los datos de cada estacién
se muestran en el cuadro 2.

Cuadro 2. Estaciones meteoroldgicas usadas para el estudio.

. fechas disponibles
CcoD Zona Alturas (msnm) Estaciones (datos-est';ciones)
min max nombre altura De a
1 Nevados 5020 6436 Chungara 4585 ene-05 dic-11
2 Alta 4460 5020 Chungara 4585 ene-05 dic-11
3 Media 4320 4460 Comisario 4379 nov-11 may-13
4 Baja 4102 4320 Sajama 4255 ene-05 jun-11

La informacidn de variable climaticas en la mayoria de las estaciones es discontinua. En el caso de las
estaciones meteoroldgicas de Chungara Ajata y Sajama, la disponibilidad de datos es escasa a partir
de diciembre de 2011 y junio de 2011, debido a la ausencia de operador y a la aparente perdida de
datos para el caso de Sajama, por lo que ha sido necesario homogenizar la informacién a través del
relleno y extension de los registros.

Para rellenar los datos faltantes de precipitacidon y evapotranspiracion potencial (ETP) se empleé el
metodo de regresidn lineal, debido a que el nimero de estaciones con informacién relevante es muy
reducido. La regresidon calcula las estadisticas de una linea utilizando el método de los "minimos
cuadrados". Calcula la linea recta que mejor se ajuste a los datos, a continuacién devuelve una matriz
que describe la linea. La ecuacién de la regresion lineal es como sigue:

y=mx+b (12).

ao“. "N

Donde los valores “y” son dependientes y estan en funcién de los valores “x” independientes. Los
valores “m” son coeficientes que corresponden a cada valor “x”, y “b” es un valor constante.

Como se puede observar en la Figura 3, el coeficiente de correlacidon existente entre las estaciones de
Chungara Ajata y Estacion Sajama es de 0,89 que esta en un rango aceptable, por lo que se opto a
realizar el relleno y ampliacidn de los registros de las variables de precipitacién desde enero de 2005
a marzo de 2013. En el anexo 1 se muestra el resumen de la informacion de precipitacion mensual
consistente, completada y extendida de las respectivas estaciones para el afio promedio historico. En
estas series se aprecia el comportamieto multianual de las precipitaciones pluviales en la zona, que
presentan una marcada estacionalidad durante el afio.
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Figura 3. Analisis de la correlacion entre los datos de precipitacidon de la estacion Chungara Ajata y la
estacién Sajama.
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Para la estacion meteoroldgica de Chungara y la Estacion Meteoroldgica Sajama, en la correlacién de
la evapotranspiracidon potencial se obtuvo un coeficiente de correlacion de 0,52 como se puede
apreciar en la figura 4. Este valor esta dentro del rango calificado como aceptable, considerando la
muy limitada informacion disponible. Bajo esta consideracién, se completaron y extendieron los
registros de evapotranspiracién desde enero de 2005 hasta marzo de 2013.

Figura 4. Analisis de la correlacién entre los datos de evapotranspiracién potencial de la Estacion
Chungara Ajata y Estacion Sajama.
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La precipitacion como variable climatica, esta influenciada por los parametros geograficos altitud,
latitud y longitud. La influencia de los parametros geograficos de superficie (latitud y longitud) en la
cordillera occidental se hace poco relevante, considerando ademas que las variaciones de la
precipitacidn respecto a la linea septentrional y meridional estd distorsionada por la presencia de la

R
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cadena de montafias andinas; por esta razéon se ha considerado Unicamente la altitud como
parametro relevante para la precipitacion (Segura, 2010).

La estacion meteorolégica Comisario, es relativamente nueva y cuenta con datos de variables
climaticas desde noviembre de 2011 a marzo de 2013. La correlacién de la gradiente precipitacidn-
altitud, nos permitio ver el comportamiento y distribucidn de estas variable a nivel espacial. Mediante
la ecuacién de regresion lineal y expresiones algebraicas simples, se generaron datos que sirvieron de
entrada al modelo hidroldgico semidistribuido de balance de humedad en el suelo, para la
modelacién de la cuenca del rio Sajama.

El calculo de precipitaciones mensuales correspondientes al periodo enero de 2005 a octubre de 2011
para el area de influencia cercana a la estacién meteoroldgica Comisario, se realizd a partir de la
ecuacion de regresion lineal obtenida en la correlacidn entre precipitacion — altitud, de las estaciones
meteoroldgicas Chungara y Sajama. A partir de ello se determind que a una altitud de 4379 msnm.,
precipita anualmente 333,26 mm/m” de agua (aproximadamente), como se muestra en el cuadro 3.
Mediante esta relacion se generaron los datos faltantes desde enero de 2005, presentados en el

anexo 1.
Cuadro 3. Parametros de la gradiente precipitacién-altitud.
Precipitacion Evapotranspiracion Potencial
Altitud (msnm) | P (mm/afio) |a b ETP (mm/afio) | a b
Chungara 4585 366,75 1163,70
Sajama 4255 323,74| 0,16 |-363,08 1047,51| 0,3521 -450,53
Comisario 4379 333,26 1090,91

b) Coeficiente de escorrentia “6”

Del agua de lluvia que cae sobre la superficie de un terreno, una parte se evapora, otra discurre por la
superficie (escorrentia) y otra penetra en el suelo (infiltracién o percolacién). El coeficiente de
escorrentia depende de numerosos factores: del tipo de precipitacién (lluvia, nieve o granizo), de su
cantidad, de su intensidad y distribucién en el tiempo; de la humedad inicial del suelo; del tipo de
terreno (granulometria, textura, estructura, materia organica, grado de compactacion, pendiente,
etc); del tipo de cobertura vegetal existente (Martinez, 2006).

Lo mencionado anteriormente hace que el calculo de este pardmetro sea complejo, para su célculo
los diferentes métodos utilizados, en su mayoria son de naturaleza empirica y difieren tanto en su
fiabilidad como en su complejidad (Ibafiez et. al.,2010). Este parametro puede ser calibrado en
funcién a diferentes factores, por lo que para el estudio se considero la ecuacion de Nadal citada en

Martinez (2006):
(23). J

C=0.25k1 k2 k3
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Donde K1 es una constante que va en funcidn a la extencion de la cuenca, K2 constante que considera
la precipitacion media anual y K3 coeficiente que considera la topografia de la cuenca. Los valores
que llegan a obtener estas constantes se muestran en el cuadro 4.

Cuadro 4. Valores de los coeficientes correspondiente a la ecuacion de Nadal.

Tabla de Nadal

Extension Lluvia media

Cuenca
cuenca anual
km? ki | mm k. | caracteristicas ks
10| 2,6| 200| 0,25 |llanay permeable 8?
20| 2,45 300| 0,5|ondulada (1);
40| 2,15, 400| 0,75 montafiosa e 1.2-
impermeable 1.5

100| 1,8 500 1
200 1,7| 600 11
500 1,4| 700| 1,17
1000 1,3| 800| 1,25
5000 1| 900| 1,32
10000| 0,9| 1000 14
20000 0,87 | 1200 15

¢) Coeficiente de recesion “a”

El coeficiente de recesién es un parametro que define las fluctuaciones del caudal permanete que
corre a través de acuiferos debajo de la superficie del suelo. Este parametro se puede calcular a partir
de la curva de recesion, los valores obtenidos se presentan a continuacion.
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Cuadro 5. Valores del coeficiente de recesion obtenidos mediante la curva de caudales medidos.

a (coeficiente de

Mes/afio Caudal Medido (m*/s) recesion)
jul-12 2,075 0,161
ago-12 1,594 0,209
sep-12 1,429 0,181
oct-12 1,390 0,328
nov-12 1,282 0,915
dic-12 2,197 0,990
ene-13 3,187 0,309
feb-13 2,878 0,900
mar-13 1,625 0,226
abr-13 1,399 0,301
may-13 1,700 0,098
jun-13 1,602 0,113
jul-13 1,715 0,161
ago-13 1,554 0,209
sep-13 1,345 0,181

2.5 Parametros de ajuste y calibraciéon del modelo

La calibracién de modelos hidroldgicos consiste en un proceso de ensayo y error, en el que se cambia
el valor de uno o varios pardmetros utilizados en el calculo de las variables hidroldgicas, con el fin de
ajustar los datos de salida del modelo a los observados en campo (Eterovic, 2008). Para realizar la
calibracion se debe escoger un periodo de tiempo en el que se tenga buena informaciéon de
precipitacion y su correspondiente registro de caudales a la salida de la cuenca (Cots, 2011).

Mediante la calibracién se pretende minimizar la diferencia entre los caudales registrados
(observados) y los calculados (simulados), optimizando el ajuste a nivel de caudales medios
mensuales. Para evaluar el ajuste se utiliza diferentes indices de ajuste para la calibracidn del modelo
hidrolégico. Alanoca (2013) realiza una recopilacidn breve que se comenta a continuacion:

a) Coeficiente de calibracion (r)
Expresa la dependencia lineal entre los caudales observados y los caudales simulados. La
ecuacion se muestra en la tabla 1.

b) Criterio de Schultz (D)
Representa la desviacion de los caudales simulados respecto de los observados, que es
recomendado para andlisis de eventos de alta resolucion temporal. La ecuacién
correspondiente se presenta en la tabla 1.

c¢) Desviacion media acumulada (MAD)
Representa la desviacién media de los caudales simulados respecto de los observados en
forma de error (ecuacién en la tabla 1).
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d) Eficiencia de Nash-Sutcliffe (E)
Este coeficiente de eficiencia es el mas utilizado en hidrologia y se define mediante la
ecuacion especificada en la tabla 1, con valores iguales a 1 muestra un mejor ajuste.

e) Errorde balance de masas (m)
Expresa en porcentaje la relacion entre el volumen del hidrograma observado y el
simulado (ecuacion en la tabla 1). Este indice es adecuado para el andlisis a nivel mensual
y anual.

f) Raiz del error cuadrdtico medio (RMSE)
La raiz del error cuadratico medio permite cuantificar la magnitud de la desviacién de los
valores simulados respecto a los observados, la ecuacion se recoge en el cuadro 6. En
general cuanto mejor el ajuste mas pequeiio es el error.

Cuadro 6. indices de ajuste para la calibracién del modelo hidrolégico. En las ecuaciones, Sobs, sim» €S la
covarianza entre los caudales observados (Q;) y simulados (Qsim,); Soss, ¥ Ssim SON las varianzas de los
caudales observados y simulados. Q.x €s la descarga maxima observada.

P . .. N° de Rango de Valor
Indice de ajuste Ecuacion .. gy L.
ecuacion variacion Optimo
Coeficiente de Sobs,sim
calibracion (r) r= ﬁ 12 0<r<1 1
obsYsim
. . n 3 — ) )
Criterio de Schultz (D) D =200 Zl—]_fl(Qélm,l )ZQL)QL 13 0 < D <o 0
max
Desviacién media 21| Qsim,i- Qi
— . < <
acumulada (MAD) MAD = n 14 0=MAD =1 0
Eficiencia de Nash- % (Quimi-0)?2
Sutcliffe (E) E=1-=5; (Sg"" @)‘2 15 —0<E<1 1
i-10 ¢~
Error de balance de % (Quimi= Q1)
masas (m) m =100 = = 16 0<m<1 0
i1 Qi
Raiz del error
cuadratico medio I (Qsimi — Q0)? 0 < RMSE
(RMSE) RMSE = |=——— 17 <o 0

Para evaluar el ajuste entre los datos de caudales observados y los simulados, se utilizd el coeficiente
de regresidn lineal “R*”, cuyo rango de variacién va de 0 a 1, donde el valor éptimo es cercano a 1. Los
datos de caudales utilizados para el ajuste pertenecen a aforos realizados en la estacién hidroldgica
“Puente Sajama” correspondientes a un ano hidrolégico del periodo de julio 2012 a septiembre 2013

(Anexo 2).
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Una vez evaluado el ajuste, la calibracidn fue realizada utilizando el método de optimizacién sucesiva,
es decir, los valores de los parametros del modelo hidrolégico semidistribuido fueron cambiados
siguiendo un andlisis de prueba y error, hasta que se alcanzaron buenas respuestas del modelo
(comparaciones de caudal modelado con caudal medido). Para este fin los parametros usados fueron
el coeficiente de escorrentia y la capacidad de almacenamiento de agua en el suelo, que varian en
funcién a la textura del suelo por zona. Los datos de caudales medios usados en la calibracion del
modelo fueron los mismos usados en el ajuste de datos de caudales modelados con caudales medidos
en campo. En el cuadro 7, se presentan los pardmetros finales del modelo, ajustados como resultado
del proceso de calibracion de la modelacidn de la cuenca del rio Sajama. En este proceso se establecié
la sensibilidad del modelo a la variacidn de los parametros, asi como se identificaron los pardmetros
gue tienen mayor influencia en los diferentes componentes del escurrimiento.

Cuadro 7. Valores usados y calibrados de los parametros del modelo hidrolégico semidistribuido en la
modelacién de la cuenca del rio Sajama.

Estaciones Trnax (MM) Coeficiente’de L > Caudal base
ZONAS escorrentia Area (m?)
nombre | COD | Saturacién (%) | mm/m’ B m®/s | mm/mes*m’
Nevados | Chungara | 1 4,3 43 0,200 58512891,29 | 0,17 7,5
Alta Chungara | 2 43 43 0,800 236576237,41 | 0,17 1,9
Media | Comisario| 3 6,0 60 0,800 94326982,83 | 0,30 8,2
Baja Sajama 4 219 219 0,800 167945733,95 | 0,30 4,6

3 RESULTADOS

Las precipitaciones mensuales y la evapotranspiracién potencial mensual fueron incorporados al
modelo de balance de humedad del suelo para generar caudales mensuales del periodo Julio de 2012
a Mayo de 2013. Los calculos fueron puestos a prueba con los caudales observados en campo. Como
se puede observar en la figura 5, el ajuste visual obtenido entre el caudal observado y el caudal
calculado esta en un rango aceptable.
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Figura 5. Ajuste del caudal observado en campo y el caudal calculado mediante el modelo
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Los parametros finales ajustados presentados anteriormente, permitieron establecer los parametros
de control de ajuste en la calibracién del modelo mediante el ajuste de correlacién lineal. Se obtuvo
un ajuste con rango aceptable de 0,74 para la calibracidn del modelado de la cuenca del rio Sajama
como se muestra en la figura 6. Dicho valor es considerado como aceptable tomando en cuenta la
limitacién en la cantidad de datos de caudal medidos.

Figura 6. Resultado del analisis de comparacion de hidrogramas medidos y modelados, en la etapa de
calibracién, mediante el coeficiente de correlacion “R*”.
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Una vez calibrados los pardmetros del modelo hidrolégico para el modelado de la cuenca del rio
Sajama, se procedid a simular datos de caudales desde septiembre de 2005 a marzo de 2013, donde
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no existen caudales medidos y considerando al mes de septiembre la época de estiaje durante la cual
la capacidad de almacenamiento de agua T,,.x Se acerca a cero. Entre los periodos mencionados se
encontrd que las mayores crecidas de caudales corresponden generalmente a los meses diciembre y
enero. En la figura 7, se presentan dos eventos extremos. El primero, en el mes de diciembre de 2007
con 5,39 m*/s, coincide con el mes de mayor precipitacion del mismo afio, con 203mm/mes. El
segundo evento corresponde al mes de enero de 2011 con 6,32 m*/s y 182mm/mes de precipitacion.

Figura 7. Analisis de hidrograma modelado y precipitacidn del periodo septiembre de 2005 a marzo

de 2013.
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4 CONCLUSIONES

El modelo hidroldgico semidistribuido de balance de humedad del suelo tuvo resultados aceptables
en la modelacién de la cuenca del rio Sajama. Ya que se obtuvo un coeficiente de correlacién R* de

0,74 siendo este resultado considerado como bueno en la escala de evaluacion del modelo
hidrolégico.

El buen desempefio de un modelo hidrolégico esta condicionado a la calidad de los datos requeridos
de entrada (precipitacidon y evapotranspiracion potencial); éste es el principal problema en los
modelos semiditribuidos y distribuidos. Un buen conocimiento de los procesos de modelacién,
control de calidad de los datos y calibracion de los pardmetros (coeficiente de escurrimiento,

capacidad de almacenamiento del suelo y coeficiente de recesion), puede ayudar a resolver esta
limitacidn.
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Anexo 1. Datos de variables climaticas consistentes, completadas y extendidas.

PRECIPITACION (mm/mes)

ETO (mm/mes) - 20%

periodo Chungara Comisario Sajama Chungara Comisario Sajama

ene-05 105,70 96,048 75,50 89,630 93,215 99,434
feb-05 152,80 138,847 149,00 73,450 86,042 91,783
mar-05 55,90 50,796 27,75 92,490 87,141 92,955
abr-05 23,20 21,082 0,00 80,231 77,452 82,620
may-05 0,00 0,000 0,00 76,309 69,356 73,984
jun-05 0,00 0,000 0,00 72,673 60,901 64,965
jul-05 4,50 4,089 0,00 71,432 59,786 63,775
ago-05 0,00 0,000 0,00 87,382 71,258 76,013
sep-05 5,50 4,998 0,50 78,470 80,874 86,270
oct-05 0,00 0,000 1,50 101,458 98,404 104,970
nov-05 12,00 10,904 14,00 103,004 110,407 117,774
dic-05 59,40 53,976 53,50 100,430 113,395 120,961
ene-06 161,50 146,753 206,75 85,319 102,519 109,359
feb-06 98,40 89,415 99,50 78,948 82,485 87,989
mar-06 44,03 40,012 38,99 86,749 87,255 93,076
abr-06 30,50 27,715 25,95 83,486 78,817 84,075
may-06 0,00 0,000 0,00 73,947 70,204 74,888
jun-06 0,00 0,000 0,00 70,253 62,894 67,091
jul-06 0,00 0,000 0,00 77,527 65,189 69,539
ago-06 0,00 0,000 0,00 83,813 72,715 77,567
sep-06 0,00 0,000 88,190 84,779 90,436
oct-06 5,00 4,543 4,75 104,096 100,357 107,053
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nov-06 29,70 26,988 19,25 102,487 106,491 113,596
dic-06 41,50 37,710 29,00 109,582 108,719 115,973
ene-07 108,00 98,138 84,75 94,687 98,677 105,261
feb-07 51,30 46,616 31,25 84,591 83,365 88,927
mar-07 64,10 58,247 95,00 81,194 87,156 92,971
abr-07 9,00 8,178 15,00 83,570 78,309 83,534
may-07 0,00 0,000 1,25 69,424 62,943 67,143
jun-07 0,00 0,000 0,50 73,059 60,088 64,098
jul-07 0,00 0,000 0,00 70,813 67,280 71,769
ago-07 0,00 0,000 0,00 79,367 69,629 74,275
sep-07 0,00 0,000 0,00 88,341 83,822 89,415
oct-07 7,50 6,815 3,80 104,018 99,445 106,080
nov-07 29,50 26,806 13,50 88,319 107,271 114,428
dic-07 30,50 27,715 16,75 105,819 105,924 112,991
ene-08 203,00 184,463 142,00 78,575 94,787 101,112
feb-08 13,00 11,813 39,75 87,565 83,393 88,957
mar-08 44,50 40,437 38,50 89,982 83,758 89,347
abr-08 0,00 0,000 0,00 85,418 78,982 84,252
may-08 0,00 0,000 0,00 74,456 69,252 73,873
jun-08 0,00 0,000 0,00 69,653 64,702 69,019
jul-08 0,00 0,000 0,00 76,596 61,363 65,457
ago-08 0,00 0,000 5,25 86,126 70,080 74,756
sep-08 2,36 2,144 0,00 94,061 82,959 88,495
oct-08 6,06 5,507 3,75 102,850 100,052 106,727
nov-08 0,00 0,000 0,00 111,650 105,541 112,582
dic-08 95,00 86,325 98,50 99,271 106,245 113,333
ene-09 38,50 34,984 27,50 100,938 100,749 107,471
feb-09 122,50 111,314 85,75 78,353 82,798 88,323
mar-09 59,50 54,067 62,25 88,595 92,624 98,804
abr-09 21,50 19,537 13,00 81,370 80,606 85,984
may-09 0,00 0,000 0,00 76,374 70,035 74,708
jun-09 0,00 0,000 0,00 72,506 60,194 64,210
jul-09 0,00 0,000 0,00 66,642 61,072 65,147
ago-09 0,00 0,000 0,00 86,355 71,334 76,093
sep-09 25,00 22,717 0,00 88,369 83,248 88,802
oct-09 33,00 29,987 5,75 108,288 100,696 107,415
nov-09 48,00 43,617 16,75 103,298 107,882 115,081
dic-09 36,00 32,713 25,00 103,367 108,354 115,583
ene-10 57,70 52,431 60,25 98,018 115,551 123,260
feb-10 72,80 66,152 60,50 84,110 108,508 115,747
mar-10 16,80 15,266 29,00 94,501 94,481 100,785
abr-10 5,70 5,180 11,25 86,839 100,187 106,872
may-10 6,30 5,725 3,75 72,491 96,930 103,397
jun-10 0,00 0,000 0,00 71,778 78,610 83,855
jul-10 2,00 1,817 0,00 76,925 95,422 101,789
ago-10 1,00 0,909 0,00 91,598 103,682 110,600
sep-10 0,00 0,000 0,00 92,613 128,114 136,662
oct-10 0,80 0,727 1,75 103,401 149,426 159,396
nov-10 0,10 0,091 0,50 117,923 100,487 107,192
dic-10 52,00 47,252 61,25 103,367 131,977 140,782
ene-11 86,70 78,783 73,25 94,435 131,378 140,144
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jul-12

ago-12

sep-12

oct-12
nowv-12

dic-12
ene-13
feb-13
mar-13
abr-13

Fecha{mes/afio)

may-13

jun-13

jul-13
ago-13

feb-11 182,00 165,381 129,50 68,145 97,947 104,483
mar-11 23,40 21,263 36,25 84,641 99,399 106,031
abr-11 32,10 29,169 15,75 85,319 94,060 100,336
may-11 13,20 11,995 11,25 73,738 83,481 89,051
jun-11 0,40 0,363 0,00 68,468 81,614 87,059
jul-11 8,10 7,360 4,37 73,323 91,380 97,477
ago-11 0,00 0,000 0,00 85,773 100,990 107,729
sep-11 0,10 0,091 0,00 88,341 98,980 105,584
oct-11 0,10 0,091 0,00 104,018 129,903 138,570
nov-11 7,80 13,200 4,08 103,813 120,069 142,763
dic-11 120,70 135,200 112,85 103,799 126,261 143,737
ene-12 168,82 153,400 159,21 97,933 102,846 110,218
feb-12 100,58 91,400 93,47 77,717 79,638 84,921
mar-12 44,03 40,012 38,99 86,969 90,259 96,498
abr-12 17,43 15,837 13,36 81,568 84,059 89,740
may-12 2,79 2,531 0,00 73,329 74,600 79,430
jun-12 0,00 0,000 0,00 71,002 71,929 76,519
jul-12 0,00 0,000 0,00 89,746 93,448 99,974
ago-12 0,22 0,200 0,00 92,994 97,177 104,038
sep-12 0,22 0,20 0,00 98,204 103,158 110,558
oct-12 5,72 5,20 2,08 102,715 108,336 116,202
nov-12 0,00 0,00 0,00 101,631 107,092 114,846
dic-12 128,32 116,60 120,19 98,080 103,014 110,402
ene-13 170,80 155,20 161,11 95,178 99,683 106,771
feb-13 56,79 51,60 51,28 89,423 93,077 99,570
mar-13 22,45 20,40 18,20 99,68 104,85 112,406
abr-13 0,00 0,00 0,00 81,52 84,00 89,681
may-13 7,48 6,80 3,78 82,42 85,03 90,800
PROM 32,60 29,94 28,33 87,65 91,05 97,41
MAX 203,00 184,46 206,75 117,92 149,43 159,40
MIN 0,00 0,00 0,00 66,64 59,79 63,77
Anexo 2. Lista de caudales medidos en campo.
. | Caudal Observado
Mes/afio (m3/s) =4=Caudal Observado (m3/s)
jul-12 2,075 3,500
ago-12 1,594 3000 K
sep-12 1,429 / \\
oct-12 1,390 2,500
nov-12 1,282 X / \
: £ 2,000
dic-12 2,197 — / \
1]
ene-13 3,187 g 1500 ‘VNNV
feb-13 2,878 v 1,000
mar-13 1,625
abr-13 1,399 0,500
may-13 1,700 0,000

sep-13

) -
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jun-13 1,602
jul-13 1,715
ago-13 1,554
sep-13 1,345

Anexo 2. Lista de caudales medidos y caudales modelados.

Suma de Caudal Medido -+-Caudal Modelado  -=-Caudal Medido
caudales de las en campo 4,00
cuatro zonas
3,50
QT (m’/s am(m’/s
( /) ( /) 3,00 N
1,16 2,07
1,22 1,59 7 >
1,18 1,43 %2,00 LN
o
=
1,33 1,39 3. \\ /7 \,\ P
1,80 1,28 M
2,05 2,20 1,00
3,34 3,19
0,50
2,93 2,88
1,46 1,62 000w e e e e e m ma
1,44 1,40 ES ® g g 5 3 E 4 5 5 g
1,10 1,70 Fecha (mes/afio)




